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Getting Started
Begin by selecting PedPro from the Windows Start menu, or from an icon on your desktop.
To begin a new pedigree file, choose File|New (i.e., select the New option on the File menu). Or to open an existing file, use File|Open.
PedPro also has some built in example pedigrees for demonstration purposes. To display one of these, choose File|Open Sample Pedigree Data
File.
If you have previously used either Breeders Assistant or Pedigree Assistant you can import the pedigree data you have previously stored. See
Importing - From Breeders Assistant and Importing - From Pedigree Assistant.
If you have pedigree data from another source that you want to import - such as from a different pedigree program or a spreadsheet - start by
creating a new file and then choose File|Import Text/CSV Data. See Importing - From Text/CSV Files.
Once the file is created/opened, the Main Window is displayed.
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Main Window
The main window is taken up mostly with a form you fill in by clicking in the various boxes.
Just follow the on-screen instructions to enter the data.
PedPro supports 3 different forms - pedigrees, trial matings and pedigree cover sheets.
Switch between them using the dropdown menu in the upper left hand corner. Normally
you would have this set to Pedigree.
The pedigree layout can be customized in many ways. To the right of the pedigree there
are various checkboxes and menus you can use to adjust the pedigree layout. E.g. you
can choose whether a signature area is to appear beneath the ancestors, the number of
ancestor generations to display, and so on. If you can't see these options, click the Show
Side Panel button which can be found in the upper right corner of the PedPro window.
To access additional layout options, click the Design Mode option (this is the bottommost checkbox in the side panel). You will then be able to change the font and and many
other stylistic aspects such as colors, line styles, watermarks etc. You can also resize the
various form elements by dragging the divider bars that appear between the boxes of the
pedigree.

The PedPro main window (Windows)

The information shown in the pedigree is configurable. For example you can add extra data fields and have them displayed in the pedigree, in either
the ancestors area, or the subject box (title), or both. For further information see Customization.
Click Print Preview to see how the form will appear when printed, use Print to print the current form. Or, use the PDF or JPEG buttons to save it
as a PDF or image file.
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Pedigree Data Files
The data you enter - names of animals etc. - is stored in pedigree data files. These files have the extension '.ped'. E.g. 'MyData.ped'.
The full version of PedPro has a limit of 1,000,000 records in a single data file.
You can have as many data files as you like. However, most likely you will need just one pedigree data file that stores the details of all the animals
you enter. The likeliest reason you might need to have multiple files would be to store records of different, unconnected, groups of animals. E.g.
different breeds or animal types altogether.
After you have started a new pedigree data file - as you do when you first install PedPro - when you try to close the program after entering data you
will be asked for a file name to save it as. Once saved, PedPro will remember the file name you most recently used, and will ask if you want to open
that file next time you start the program.
You should keep your pedigree data file(s) in the same location (folder) on your computer as you keep any other documents. Just as it is important to
backup your other documents, it is essential that you backup your pedigree data file(s) from time to time: if you lose a pedigree data file
you will lose ALL the information you have ever entered into it.
A pedigree data file stores the name of every animal you enter, along with its associated information such as date of birth, parentage and so on.
When you create a new data file it starts out with a number of predefined data fields, e.g. for Breed and Registration Number. It is easy to add new
data fields. E.g. you might want to add a field for eye color, or weight. For further information see Customization - Data Fields.
Most of the time when you use PedPro the existence of the underlying pedigree data file is 'hidden', because you don't tend to work with it directly.
Probably you will spend most of your time with the program entering, viewing and printing pedigrees. But there are some operations that apply to a
whole data file. E.g. you can import from Breeders Assistant, Pedigree Assistant, and text (CSV) files when creating a new data file, and export data
to text (CSV) files. You can also print a table containing the entire contents of a pedigree data file. And, you can also save pedigree data in other
formats by exporting as HTML, PDF and XML.
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Printing
Pedigrees and Other Forms
To print a pedigree or other form, just click the Print button (above the displayed form). If your computer has more than one available printer, use the
dropdown menu in the right side panel to select the required printer.
The form as shown in the main window is fairly close approximation of how the printout will look. But for a more exact on-screen display, click the
Print Preview button first.
To alter the paper margins and orientation (portrait/landscape) prior to printing, use the buttons in the right side panel.

Exporting As PDF/Image Files
Instead of printing to a physical printer, you can also 'print' to a PDF or image file. To do this, click the PDF or JPEG buttons instead (at the top of the
PedPro window), then select a filename to save as.

Printing Data
As well as printing pedigrees and other forms, you can also print the data within your pedigree file as a table, somewhat like a spreadsheet. To do
this, select File|Print Data. Or, to export to a PDF, HTML, XML or text file, select File|Export Data. Exporting as an XML file is useful when you need
to transfer data to a spreadsheet.

Margins
PedPro sets default paper margins depending on your printer and its setup.
In most cases, this should produce a sensible and consistent margin on all sides of the paper.
But if not, you can change this - click the margins button in the right side panel (

).

Understanding Printer Margins
This section contains a more detailed explanation of how PedPro sets paper margins, and how margin settings work with your printer and chosen
paper size.
Most printer devices have physical limitations on their printing capabilities. Obviously the supported paper sizes vary. But in addition, most printers
are not physically capable of printing on the entire sheet of paper: there are usually parts of the sheet that the printer simply cannot physically print
on. You can instruct PedPro to attempt to print onto that maximum part of the paper by selecting the Full page option within the Print Margins
window.
Your computer will also have a default margin setting for the chosen printer. This should be a sensible default; its actual size is system specific. You
can instruct PedPro to use the default margins by selecting the Use printer default margins option within the Print Margins window. This is the
normal setting and an in ideal world will produce a good result without you having to change anything.
But you can opt to override the default margin selection by disabling both the Full page and Use printer default margins options in the Print
Margins window, and then entering the actual margins you would like. Measurements can be entered in a variety of units including centimeters (e.g.
you could enter 1.2cm) and inches (e.g. 0.25in). Note that setting margins smaller than the physical minimum margins that your printer is capable
of generally will not produce acceptable results - you will end up with parts of the printout 'chopped' off. You may find you need to experiment with
different sized margins until you get a pleasing result.
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Form Design
The layout of pedigrees and other forms may be customized in many ways. You can:
Include or exclude elements such as photos, logo, or pedigree signature
Set a background image (watermark)
Change fonts and text color
Set border thickness, style and color
Set background colors
Change the displayed text, including selection of data fields
Resize form elements, such as photos and ancestor cells
The way to go about changing many of these layout properties is fairly obvious, and you may well find that you do not need to refer to this guide in
order to make those changes. However, reading the information given here will give you a better understanding of how a form is structured, and this
will help you customize the appearance more effectively.

TIP: Be sure to click the Design Mode option (in the right side panel - if you can't see the side panel then click the Show Side Panel button which
can be found in the upper right corner of the PedPro window). This gives access to more options and causes 'resize bars' to appear which can be
moved to resize form elements.

TIP 2: Many layout settings can be accessed through popup menus. Just point at whatever you want to change, then right-click to see the menu.

Chapter Contents
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Structure
Box Settings
Form Defaults
Ancestors
Text
Text Style
Photos
Background Photos
Photo Cropping
Photos With Text
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Form Design - Structure
PedPro supports several different types of form: Pedigree, Cover sheet and Trial Mating. Use the dropdown menu in the upper left corner of the
main window to switch between forms.
Each form is made up of 1 or more different elements or 'boxes'.
To resize any of the boxes in a form, first click the Design Mode checkbox (in the right side panel), then drag the resize bars that appear in the main
display.

Pedigree Form
The pedigree layout begins with several boxes positioned horizontally adjacent to each
other in a 'header band' that runs along the top of the pedigree: the Logo, Title, Details,
Photo and Right Logo boxes. Beneath the header is the main element of the pedigree:
the Ancestors box. Below the ancestors box is the Signature box.
All of the header boxes and the signature area are optional, and it is quite normal to only
use 2 or 3 of these. Use the check boxes in the right side panel to select the elements you
want to include.
The two Logo boxes display static content that remains the same irrespective of
whichever pedigree you are viewing. I.e. their content does not vary as you switch from
one pedigree to another. In a typical setup you would use at most one of the logo boxes,
and which one you use is just a matter of personal style.

Pedigree Background
There is also a 'background' box which covers the whole pedigree, and by default is not
Pedigree Structure
visible at all because it has no border, padding or content, and all the other boxes are
superimposed on top of it. The main use of the background is for displaying a watermark
image. To do this right-click over the pedigree and choose Background Settings from
the popup menu. Typically a faded photo is used so as to not obliterate the pedigree that will be drawn on top. By adjusting other properties of the
background you can achieve other effects, e.g. to set a border which will enclose the whole pedigree.

Cover Sheet
The cover sheet layout comprises a Title box, which is always present, and optionally up
to 3 additional boxes: the Photo, Reverse and Inside Flap.
A cover sheet is intended to be printed on the reverse side of the same sheet of paper as
the pedigree itself - i.e. you feed the printed pedigree back through the printer, reverse side
up so as to print the cover sheet on the other side.
The cover sheet layout is designed to be folded either once (in half), or twice (for a
'booklet' style folded pedigree), or not folded at all.
Use the 'Style' dropdown menu (in the right side panel) to select the fold style. There is
also a check box to enable/disable the Photo box.
Note that the cover sheet form does not have a background (watermark image).

Cover Sheet Structure

Trial Mating
The trial mating layout is very similar to a pedigree, except that it does not include space
for a signature, and instead of the normal (animal) Photo and Details boxes, there are
separate boxes for sire and dam.
As with the pedigree layout, the ancestors box is always present in a trial mating but all
other boxes are optional. It can have a background (watermark) image.

Trial Mating Structure

9

Form Design - Box Settings
Most boxes in a form are laid out in a similar way. Each box has a border that encloses
some kind of content - such as text or a photo (or both). Separating the border and the
content area is a padding gap.
Both border and padding are optional, and can be zero sized in which case the box
comprises solely its 'content' area. E.g. the pedigree 'ancestors box' typically has no
border and zero padding and is entirely filled with the table of ancestor cells.

Box Border
The border is defined by its thickness, color, line type (solid, dotted or dashed) and corner
type (square, or various forms of rounded corner).
In order to have a border appear around any form element, it needs to have a border style
other than None, a non-zero border thickness, and a visible border color. It is not sufficient
to just set just one of these properties.
Box Structure

Box Padding
The padding is simply an amount of space separating the border from the box's content.
The thicknesses of the top, left, bottom and right padding are set separately.

Fill (Box Background)
The Fill Color and Fill Style control the background of the box content and any padding. The style is normally 'solid' but can be set to a pattern in
which case the form background will show through. The default setting is for all boxes to have a transparent fill color, thus allowing anything that is
beneath the box (such as a background watermark) to show through.
You can also set the Fill Opacity, which controls the extent to which anything that is 'underneath' the box is allowed to 'show through' the fill pattern.

Box Content
The content typically comprises text and/or a photo, and some settings that affect their appearance such as font size, text color/alignment and photo
position/alignment.
For further details please see Form Design - Text, Form Design - Text Style and Form Design - Photos.
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Form Design - Form Defaults
For many boxes all their settings can be set independently and explicitly. The main exceptions to this are the individual ancestor cells that make up
the ancestors box within a pedigree or trial mating. For further information see Form Design - Ancestors.
Often, however, you will want to make consistent changes that apply to groups of boxes such as all the header boxes, or to an entire form. E.g. to
set all header boxes to have the same non-white background colour, or to change the font face for the whole form.
To avoid having to make the same, repeated, changes to lots of boxes, the box settings are arranged according to a hierarchical grouping structure.
Most settings for any given box are worked out automatically, usually by 'inheriting' them from their parent group.
At the base of this settings hierarchy is a set of default values known as the Form Defaults. In many cases, the best way to effect a change that
applies to the whole form is to alter the form defaults: just right-click over any part of the displayed form and select the form defaults option from the
popup menu.
E.g. the Title box in a pedigree inherits its border style, by default, from the 'Header' settings. But likewise so do the Logo box and Photo boxes. So,
you can change the border style for all boxes in the header by changing the border style in the Header Settings window (right-click over the pedigree
and select Header Settings from the popup menu).
The following table shows the grouping structure.

Group/Box

Property

Automatic Value

Form Defaults

Padding

0.1 inches all round

Border Color

Black

Fill Style

None

Fill Color

Transparent

Font Face

System Default

Font Size

11pt

Box Gap

0.1 inches all round

Text Color

Black

Text Alignment

Horizontally centered, vertically middle

Padding

None

Border Color

Inherits from Form Defaults

Border Style

None

Fill Style

Inherits from Form Defaults

Fill Color

Inherits from Form Defaults

Font Face

Inherits from Form Defaults

Font Size

Inherits from Form Defaults

Text Alignment

Horizontally centered, vertically middle

Text Color

Inherits from Form Defaults

Photo Position

Bleed, 100%, centered

Padding

Inherits from Form Defaults

Border Color

Inherits from Form Defaults

Border Style

Medium rounded solid line, 0.01 inch thickness

Fill Style

Inherits from Form Defaults

Fill Color

Inherits from Form Defaults

Font Face

Inherits from Form Defaults

Font Size

Inherits from Form Defaults

Text Alignment

Inherits from Form Defaults

Text Color

Inherits from Form Defaults

Padding

Inherits from Header Group

Border Color

Inherits from Header Group

Border Style

Inherits from Header Group

Fill Style

Inherits from Header Group

Fill Color

Inherits from Header Group

Font Face

Inherits from Header Group

Font Size

Inherits from Header Group, but made 40% larger

Text Alignment

Inherits from Header Group

Text Color

Inherits from Header Group

Form Background

Header Group

Logo Box
Right Logo Box
Animal Photo Box
Pedigree Signature
Sire/Dam Photo Box
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Pedigree Title Box
Trial Mating Title Box

Ancestors Box

Cover Sheet Inside Flap
Cover Sheet Reverse

Cover Sheet Title

Photo Position

Bleed, 100%, centered

Padding

Inherits from Header Group

Border Color

Inherits from Header Group

Border Style

Inherits from Header Group

Fill Style

Inherits from Header Group

Fill Color

Inherits from Header Group

Font Face

Inherits from Header Group

Font Size

Inherits from Header Group, but made 60% larger

Text Alignment

Inherits from Header Group

Text Color

Inherits from Header Group

Photo Position

None

Padding

None

Border Color

Inherits from Form Defaults

Border Style

None

Fill Style

Inherits from Form Defaults

Fill Color

Inherits from Form Defaults

Font Face

Inherits from Form Defaults

Font Size

Inherits from Form Defaults

Text Alignment

Inherits from Form Defaults

Text Color

Inherits from Form Defaults

Photo Position

Bleed, 100%, centered

Padding

None

Border Color

Inherits from Form Defaults

Border Style

Medium rounded solid line, 0.01 inch thickness

Fill Style

Inherits from Form Defaults

Fill Color

Inherits from Form Defaults

Font Face

Inherits from Form Defaults

Font Size

Inherits from Form Defaults

Text Alignment

Inherits from Form Defaults

Text Color

Inherits from Form Defaults

Photo Position

None

Padding

Inherits from Header Group

Border Color

Inherits from Form Defaults

Border Style

Inherits from Form Defaults

Fill Style

Inherits from Form Defaults

Fill Color

Inherits from Form Defaults

Font Face

Inherits from Form Defaults

Font Size

Inherits from Form Defaults, but made 60% larger

Text Alignment

Inherits from Form Defaults

Text Color

Inherits from Form Defaults

Photo Position

None
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Form Design - Ancestors
The Ancestors box within a pedigree or trial mating makes up most of the printed page.
The settings that control its appearance are set in two quite different ways.
Firstly, as a 'box' in its own right - just as with other boxes such as the Title box or Logo
box - you can control its border, background, and so on. For further information see Form
Design - Box Settings.
But, separately, you can control the appearance of the individual ancestor cells within the
ancestors box.

Ancestors Box Settings
The default settings for the ancestors box itself are that it has no border, no padding, and
no fill color. Which means that, by default, it is made up solely by its content - the grid of
ancestor cells. However it is possible to change these settings at the box level, and this
can be used to achieve effects such as enclosing the grid of ancestor cells within its own
border, or to give the grid a different background colour or image. To make any of these
changes, right-click over the ancestors box and select Ancestors Box Settings from the
popup menu.

Ancestors Box

Apart from the fill color, the settings of the ancestors box itself do not have any effect on the individual ancestor cells. Those settings are controlled
quite separately - see below. The ancestors box fill color only affects the individual ancestor cells in that it usually 'shows through' because, typically,
ancestor cells use a transparent fill color.

Ancestor Cell Settings
In much the same way as box settings are, by default, automatically determined using a hierarchical structure, settings for the individual ancestor
cells are governed by a hierarchical arrangement.
Firstly there is a set of default settings for all ancestor cells, that can be applied to every generation of ancestry.
Next there is a group of settings for each different depth of ancestry. E.g. in a 5 generation pedigree generally there is much less space available on
the page for each ancestor cell than there is with, say, a 3 generation pedigree. And so, it makes sense for groups of settings to be set separately for
different depths of ancestry.
Finally there is a separate group of settings for each distinct generation within a pedigree of given ancestry depth. E.g. for the parents in a 5G
pedigree you might want to use a smaller font scaling than for the parents in a 3G pedigree.
If you right-click over the ancestors box you will see these three different groups of 'Ancestor Cell Settings' you can change. E.g. if you have a 4
generation pedigree shown, and you right-click over a grandparent cell, you will see a popup menu that includes these options:
- Ancestor Cell Settings - G2/4 Specific - these are the generation-specific settings
- Ancestor Cell Settings - G4 Specific - these are the ancestry-depth-specific settings
- Ancestor Cell Settings - Default - settings common to all depths/generations.

Hierarchy Group

Property

Ancestor Cell - Default (common to every generation for all ancestry depths) Border Color

Ancestor Cell - GN Specific (common to every generation for a specific
depth 'N' of ancestry)

Ancestor Cell - GX/N Specific (i.e. specific to generation 'X' within ancestry
depth 'N')

13

Automatic Value
Inherits from Form Defaults

Border Style

Medium rounded solid line, 0.01 inch
thickness

Fill Style

Inherits from Form Defaults

Fill Color

Inherits from Form Defaults

Font Face

Inherits from Form Defaults

Base Font Size (PreScaled)

Inherits from Form Defaults

Text Color

Inherits from Form Defaults

Text Alignment

Horizontally centered, vertically middle

Border Color

Inherits from Ancestor Cell - Default

Border Style

Inherits from Ancestor Cell - Default

Fill Style

Inherits from Ancestor Cell - Default

Fill Color

Inherits from Ancestor Cell - Default

Font Face

Inherits from Ancestor Cell - Default

Base Font Size (PreScaled)

Inherits from Ancestor Cell - Default

Text Alignment

Inherits from Ancestor Cell - Default

Text Color

Inherits from Ancestor Cell - Default

Photo Position

None

Box Gap

Set according to ancestry depth

Padding

Set according to ancestry depth

Border Color

Inherits from Ancestor Cell - Gn

Specific
Border Style

Inherits from Ancestor Cell - Gn
Specific

Fill Style

Inherits from Ancestor Cell - Gn
Specific

Fill Color

Inherits from Ancestor Cell - Gn
Specific

Font Scaling

Set according to ancestry depth and
generation

Text Alignment

Inherits from Ancestor Cell - Gn
Specific

Text Color

Inherits from Ancestor Cell - Gn
Specific

Photo Position

None

Setting Text Size in Ancestor Cells
The size of text - i.e. the font height - within ancestor cells is set by combining a base font height (in pts) with a scaling factor (a percentage). The
base font height is set within either the 'Default' ancestor cell settings, or the ancestry-depth-specific settings. The font scaling is set within the
generation-specific ancestor cell settings.

TIP: To increase or decrease the text size for all ancestor generations uniformly, change the base font height (i.e., adjust the 'Default' or 'GN
Specific' settings). To increase or decrease the text size for a specific generation, change the font scaling for that generation (i.e., adjust the 'GX/N
Specific' settings).

Ancestor Photos
It is possible to display the photo of an ancestor within its cell in the ancestors box.
By default these are not displayed however as it is normal for ancestor cells to display text information only - name, breed etc.
But to display photos in ancestor cells all you need do is to change the photo position settings for the relevant ancestor cells - open the appropriate
Settings window and then adjust the photo positioning. In order to have both text and photo appear you need to reduce the photo size and align both
the text and the photo appropriately. For further information see Form Design - Photos With Text.
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Form Design - Text
This section describes how the text that is displayed within boxes is constructed. For details on the appearance of text (the font face, size etc.) see
Form Design - Text Style.
All boxes can display a text string. Some boxes - but not all - can also include field codes in the text that are placeholders for data taken from the
animal records. You can do this with the boxes for the pedigree Title, Details, Photo and for the cells within the ancestors panel. All the cover sheet
boxes support field codes, as does the trial mating Details box and ancestor cells. All other boxes - such as the Logo, Right Logo and the form
background - do not support field codes.
E.g. if you set the text for the Title box of a pedigree to:
Pedigree Of [#Name]
then the [#Name] part will be replaced with the animal's actual name. So, if you had entered a record for an animal called 'Fred', then the pedigree
Title box will contain 'Pedigree of Fred'.
Generally, the text string does not control the formatting such as font face, size and color. However there are some exceptions to this - see
Formatting Codes (below).
It is possible to change all the text within the boxes of all forms. Just right-click over the relevant box and select the appropriate 'Settings' entry from
the popup menu.
Anything that is enclosed in square brackets, such as [#Name] in the above example, represents one or more data fields and will be replaced with
data taken or deduced from the current record. Anything that is enclosed in curly brackets (braces), such as {S 120}, represents a formatting
code, which will affect the appearance of the following text but not the text itself. Field and Formatting Codes are described below.

Embedded HTML
It is possible to use some HTML tags within the text. To have these work as expected you need to check the HTML option that is beneath the text
box in the settings window.
The following HTML tags are supported: <b>, <big>, <br>, <em>, <font>, <i>, <li>, <ol>, <p>, <s>, <small>, <span>, <strong>, <sub>, <sup>, <u>,
<ul>. Some CSS styling is available by setting a 'style' attribute e.g. in conjunction with the <span> tag. The following CSS properties can be used:
background-color, color, font-family, font-size, font-style, font-weight, text-decoration, font.

Field Codes
Field codes act as placeholders for data taken from the animal records. They are always enclosed in square brackets and can take one of 2 formats:
[FIELD-NAME]
[LIST-TYPE FIELDS-SELECTOR LIST-STYLE SCALE-FACTOR]
The first and simpler format is used when a single field value is required, as in the above example. The FIELD-NAME parameter is simply that: a
valid field name (see below).
The second format is used to expand a list of field values. It takes 4 parameters although only the first is actually required; the others are optional.
The parameters are separated by spaces.

Parameter

Description

LIST-TYPE

Used to specify whether the list of field names are to be labeled or not, and whether or not upper/lower case conversion is to be
carried out.
Use $ for a labeled field list, or @ for an unlabelled list. If you want to force the list to be in lower case, add the letter L. Or add U to
force to upper case.
E.g. $L would generate a list of lower cased, labeled, field values.

FIELDSThis specifies which fields are to be included.
SELECTOR In its simplest form it just consists of * - i.e. an asterisk - which causes it to default to an automatically determined list of fields
deemed appropriate for the context in which the text box appears. This is the most commonly used setting for the selector.
Alternatively, to have a specific list of field values, the selector can be given as a comma-separated list of field names. There
should be no spaces in the list; if you cannot avoid this because there are fields whose names include spaces, then you must
place the whole list in single quotes. E.g. 'Breed,Eye Color'.
Finally, the selector may use the syntax !FIELD-LIST, which acts like * except that the fields named in the list are excluded. E.g.
if you wanted to have a field list that included all fields deemed appropriate for the given context, but not the 'Breed' or 'Color' fields,
you could use !Breed,Color.
You can control which fields PedPro deems appropriate to be used in any given form context with the * or !FIELD-LIST forms of
selector by setting the 'Default Field Usage' options within the File Settings window. See Customization - Data Fields. E.g. you
might want the 'Color' field to appear in the cells of the ancestors box for the parent and grand-parent generations but not beyond.
Note that you can also adjust the order in which fields are displayed - see below for details.
The FIELDS-SELECTOR defaults to * if not given.

LISTSTYLE

This controls how the fields are separated.
COMMA (or just ,) outputs the fields as a comma separated list.
UL outputs the fields as a bullet list, with each field on a separate line.
OL outputs the fields as a numbered list, with each field on a separate line.
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L outputs the fields as a simple list (without bullet or number prefix), with each field on a separate line.
T outputs the fields as a table without borders.
TB outputs the fields as a table with borders.
The LIST-STYLE defaults to , if not given.

SCALEFACTOR

This is an optional percentage value, by which the text size will be scaled. It defaults to 100 (i.e., unscaled).

Examples
[$
[@
[@
[$

* L]
A labeled list of field values, without case conversion, with each field on a separate line.
* , 70]
A comma-separated list of unlabelled field values, scaled to 70% text size.
!Breed BL] A bulleted list of unlabelled field values, excluding the 'Breed' field.
* TB]
A bordered table of labeled field values, without case conversion.

Field Names
Field names are managed separately for user-defined and system fields.
User-defined fields - i.e. ones that you can add and remove to your data file - have names that you set yourself using the User Fields tab of the File
Settings window. For further information see Customization - Data Fields.
System fields - i.e. those that are built-in by PedPro - have both a hard-coded internal name and also a name derived from the current terminology
settings. To alter these names, use the Terminology tab of the Preferences window. Hard-coded names always begin with the # symbol. E.g. the
sex field has the hard-coded internal name #Sex but also a terminology-derived name which, unless you change it, is simply Sex. For further
information see Customization.
When PedPro creates a new data file, any system fields that are explicitly used in all the standard forms are deliberately named using the hardcoded internal names, such as #Sex, so that they will work correctly irrespective of how you might change the terminology settings.

Field Ordering
You can configure the order in which fields are output when a field code expands to 2 or more fields. To do this, use the Form Field Order tab of the
File Settings window. For further information see Customization - Data Fields.

Formatting Codes
Formatting codes are a means of altering the visual appearance of the text but not the text itself.
Currently there are only 2 formatting codes but more may be added in future releases.

Formatting Code

Description

{S percent}...{/S}

Scales the enclosed text by the given percentage size.
E.g. Apple {S 75}Pear{/S} would output 'Apple Pear' but the 'Pear' would be in a smaller font.
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Form Design - Text Style
This section covers the appearance of text - font face, font size, text color and alignment.
For details on how to change the actual text itself (the letters etc.) see Form Design - Text.

Font Face
The font face (i.e., the typeface) requires little explanation other than to say it can be set separately for each box should you want that.

Base Font
You can set a base font for the whole form, and often this is the best place to change it: do it this way and you can change the typeface for the whole
form in one place (assuming all the boxes default to their normal, automatic, setting) and have PedPro scale it appropriately in different parts of the
form.
To set the base font, be sure to turn on the Design Mode option (this is in the right side panel). You will then see font size and style controls.

Font Size
Font sizes are, by default, set in relation to the base font which is scaled appropriately for different parts of the form.
To override the default font size within a specific box, right-click over it, select the option to change the settings for that box, then adjust the font size
within the relevant settings group. E.g. the font size for the pedigree title box defaults to 160% of the base font size. To use a fixed point size instead,
right-click over the title box, select Title Settings from the popup menu, turn off the 'Automatic' font sizing, then set the point size as you wish.
Font sizing for ancestor cells is controlled slightly differently. The base ancestors font size can be set in either the settings specific to any ancestry
depth (i.e. any number of generations), or in the settings for a specific no. of generations. E.g. with a 4 generation pedigree, when you right-click over
the ancestors you will see options to set Ancestor Cell Settings - 4G Specific and Ancestor Cell Settings - Defaults. This font size is then
further adjusted by a separate font scaling which is set for each ancestor generation. E.g. when you right-click over the grandparents you will see an
option Ancestor Cell Settings - G2/4 Specific.

Text Color
The text color requires little explanation other than to say it can be set separately for each box should you want that. Note that text color can also be
set in the form defaults, and usually this is the best place to change it because then you will have the same text color used consistently throughout
the form (assuming all the boxes default to their normal, automatic, setting).

Alignment
The text in a box can be aligned both horizontally and vertically.
The horizontal alignment can be either Left Aligned or Center Aligned.
The vertical alignment can be Top Aligned, Middle Aligned or Bottom Aligned.
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Form Design - Photos
PedPro makes it easy to include images in pedigrees and other forms. You can use photos as background images (watermarks), have a dedicated
photo box in the pedigree heading for the subject animal, use a photo as a logo, and you can include photos in the ancestors box.
Commonly used image formats are supported, including JPEG, PNG and TIFF. Whilst often used for images that are actual photographs, they can
of course be images produced in other ways, such as clipart or line drawings.

Photo Boxes
These are the boxes that can appear in the pedigree or trial mating header that are
intended for photographs or other images. There are several such boxes, all of which are
optional.
The Logo box, which on the left side of the header, is intended to hold an image that is
your 'logo' - such as a graphic that promotes your kennel, cattery etc. It displays an image
that does not vary as you move between forms. In a pedigree, the Photo box, which is to
the right of the Title box, holds the photo of the subject animal. The photo displayed here is
taken from the current record and so varies as you move between pedigrees.
Trial mating forms do not have a Photo box, but instead have separate Sire Photo and
Dam Photo boxes that operate in the same way.
The Right Logo box, at the right hand side of the header, acts like an alternative 'logo'
box. If you prefer your logo to appear on the right of the header, use this instead of the
normal Logo box.
To choose the image that is displayed in any of these boxes, just click the box and use the
Add Photo button to select a file.

Pedigree Structure

By default, these boxes do not include any text, and have the photo positioning settings set so that the image will completely fill the available space.
You can change this however.

Embedding Photos In Data Files
Photos are normally stored in files such as JPEG files.
When you 'enter' a photo in PedPro, usually all you are doing is choosing the name of a file containing that photo. Then, whenever PedPro needs to
show that photo, it loads the file. This means that you need to ensure that the file remains available whenever PedPro needs it. The information that
PedPro saves (stores) for the photo is the filename.
In typical use this is what you would normally want, and it is what most other applications expect. It has the benefit that if the photo is updated, then
the updated image will automatically show in PedPro next time it is run. But it has the disadvantage that if you copy your pedigree data file elsewhere,
or move the photos on your computer (e.g. to a different hard drive or folder), then the 'link' between your PedPro data file and the photo file is broken.
The photo no longer displays within PedPro until you update the filename.
PedPro offers an alternative way to handle photos, and that is to embed the photos directly within your pedigree data file. Because the photos are
now automatically kept in the same file as the data, they can never be 'lost' due to moving the photo files elsewhere, or by copying the data file to
another computer without also copying the photos. The downside is that your data file can potentially become huge, and the photos cannot be
automatically updated by changing the external photo files.
By default, photo files are not embedded. To change this setting, select File|Settings and check/uncheck the Embed photos in data file option.
Note that changing this option only affects photos entered from that point on. E.g. if you turn this setting on, but have previously 'entered' photos in
animal records (i.e., PedPro has 'stored' those photos as the external filenames), they will remain as externally linked. But all photos you add from
this point will be embedded.

Photo Filters
When you enter a photo by selecting a file, there are Brightness, Contrast and Gamma filters you can use to adjust the photo appearance.
Brightness and contrast are self explanatory. Changing the Gamma is a way to adjust the relative proportions of bright and dark areas in the photo.
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Form Design - Background Photos
You can set an image to be displayed in the background, behind the whole pedigree. This is typically used to display a faded, or watermark, image.
To set the watermark, right-click over the pedigree and select Background Settings from the popup menu. Then click the Add Photo button.
You should generally use a lightly colored image for the watermark, else it will tend to obliterate the pedigree drawn on top. The Brightness and
Gamma settings (also in the Background Settings window) can be helpful here. The 'gamma' is a way to adjust the relative proportions of bright
and dark areas in the photo.
The background image will, by default, be scaled so that it covers the entire page (within the margins) whilst retaining aspect ratio. In practice what
this means is that, unless your background image has the same aspect ratio - i.e. it has the same 'shape' - then parts of the image will be cropped.
Sometimes this is not the behaviour you would like. In this case you can change the Mode within the photo positioning settings. This can be found on
the Layout tab of the Background Settings window.
Alternatively, use a photo editor to adjust the aspect ratio of your image - by cropping it so that it has approximately the same aspect ratio as the
page.

NOTE: As far as PedPro is concerned, the background of the form is just another 'box'. It is just special in that it (a) covers the whole page, and (b) it
lies 'behind' all the other boxes. But because it is a box it can have its own photo (which is how the watermark is set) but can also have text if you so
wanted it. See Form Design - Box Settings, Form Design - Text, Form Design - Text Style, Form Design - Photos, Form Design - Photo Cropping
and Form Design - Photos With Text.
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Form Design - Photo Cropping
This help topic explains how to control image sizing and cropping, and how the various photo 'Mode' settings can be used.
To alter how a photo is sized/cropped, there are two main approaches:
Resize the area in which it is displayed to change its aspect ratio to match the image. The aspect ratio of a photo is its width divided by its height.
By resizing the area in which the photo is to be drawn so that it matches the aspect ratio of the photo itself, little or none of it will be cropped. To
do this, first click the Design Mode checkbox (in the right side panel), then drag the resize bars that appear in the form display. To hide the bars,
just click Design Mode again. This is obviously not possible with a background (watermark) image (although you can adjust the margins).
Or, alter the photo positioning Mode.
When a photo is displayed, the default setting is for PedPro to stretch it so it occupies the entire area in which it is drawn, whilst retaining its aspect
ratio. This is the so-called Bleed setting and what it means is that, unless the aspect ratio of the photo matches that of the area in which it is drawn,
some of the photo will be cropped - i.e. chopped off. Depending on the shape of the image, parts of either the left+right sides, or the top+bottom, will
be cropped.
E.g. Say you are doing the pedigree for a dog and have added this photo to a dogs record:

The aspect ratio of this photo is about 1.5: i.e. its width is about 50% more than its height.
Now, lets say you have decided that you want to set the Photo box in the pedigree to be approximately square. So, you resize the boxes in the
heading (by clicking Design Mode and then dragging the resizing bars) to get the heading looking like this:

Note the Photo box on the right is approximately square, and the image of the dog has been cropped on the left and right sides. The image has been
stretched so it lies snugly against the box's borders.
There are four different settings for the photo Mode. To change it for a box, just right-click over the box and select the appropriate 'Settings' option
from the popup menu. E.g. to change it for the animal Photo box in a pedigree, right-click and select Photo Settings. The Mode setting is found
within the 'Photo Position' group which will be on either the Layout or Photo tabs (it varies from one 'Settings' window to another).

Mode
Setting Description

Example

Bleed

The photo is drawn so that it entirely fills the box, right up to the border, and it is cropped if its aspect ratio does not match
that of the box.

Stretch

The photo is drawn so that it fills the box, right up to but not including the padding, and it is cropped if its aspect ratio does
not match that of the box. This usually looks better without rounded borders.

Normal

The photo is drawn at the maximum possible size whilst retaining its aspect ratio, but without cropping. This will usually
result in there being space either above/below or left/right of the photo. Padding is respected.

None

No photo is shown at all. Whilst this might not seem very useful, it is often used within ancestor cells so that pictures that
have been stored in the ancestor records do not (normally) show in the ancestors table.
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Form Design - Photos With Text
The content of most boxes can be made up of text and/or a photo. In many situations a box displays either text or a photo but not both. For this
reason most boxes format both their text and photo content to use all the available space, centered both horizontally and vertically. If both are present
they will superimpose each other, with the text uppermost.
To change this behaviour you can alter the a box's Photo Position settings. Note that when both text and a photo is present, unless you want them to
overlap you need to ensure that you arrange the photo position settings so there is enough space left over for the text.
The Photo Position settings are as follows.

Setting

Description

Mode

Can be one of four modes.

None - no photo is shown at all.
Bleed - the photo is drawn so that it entirely fills the box, right up to the border, and it is cropped if its aspect ratio does not match that
of the box.

Stretch - the photo is drawn so that it fills the box, right up to but not including the padding, and it is cropped if its aspect ratio does
not match that of the box.

Normal - the photo is drawn at the maximum possible size whilst retaining its aspect ratio, but without cropping. This will usually
result in there being space either above/below or left/right of the photo.

Alignment Can be either Centered, or aligned to Left/Right/Bottom/Top.
Scaling

A percentage value, 1-100, that controls how much of the available space (width and/or height) is to be used when sizing the photo
for display.
If the Alignment is Top or Bottom, the scaling is applied to the box height.
If the Alignment is Left or Right, the scaling is applied to the box width.
If the Alignment is Center, the scaling is applied to both width and height.
Scaling is ignored in bleed mode.

Gap

The gap - i.e. distance - that is to ideally separate the text from the photo.

Photos With Text - Worked Example
This example shows how to change box settings to display photos within the ancestor cells for the parent generation in a pedigree. The same
principle applies to all boxes that can hold both text and a photo.
1. Choose File|Open Sample Pedigree Data File and select the Cat Pedigree example. Click OK.
2. Display the pedigree for 'Arripay Little Wonder': find this cat in the list of cats on the left side, then click to select it. You should now have his
pedigree displayed. His sire should be 'Arripay Fictitious Beast', with no dam set (in the sample data, 'Arripay Fictitious Beast' has a photo set, so we
have deliberately chosen a pedigree that positions this animal as a parent; if you right-click over the sire in the pedigree, then choose 'Edit Sire' from
the popup menu, then click onto the 'Photo' tab you will see the photo).
3. At this point, the ancestor cell for the sire in the pedigree will not show the photo. Thats because the default photo position settings in an ancestor
cell have the photo mode set to 'No Photo':

4. Next, right-click over the sire box, then select Ancestor Cell Settings - G1/4 Specific from the popup menu. Click onto the Layout tab. In the
Photo Position group, uncheck the Automatic box and then set the Mode to Bleed Photo. Click OK. The pedigree now changes, and the sire's
photo now completely fills the ancestor cell, with the text superimposed:

5. But this isn't quite what we want, because we do not want the text on top of the photo. Re-open the same Settings window, but this time change
the Photo Position so that the Mode is set to Normal Photo, the Alignment is set to Photo At Bottom, and the Scaling is set to 50%. Click OK.
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The pedigree again changes, and now the sire's photo is smaller and aligned to the bottom. But the text is still the same size, and whilst the text has
moved up it still partly overlaps the photo:

6. The problem now is that the text is just too large. By changing the photo alignment so the photo is at the bottom, we have caused PedPro to
attempt to put the text above it, and whats happened is that it has drawn the text centered in the space above the photo but because the text is still
too large it has overflowed the available text space, both above and below. The overflow above has been clipped to the text box boundary, and the
overflow beneath has overlapped the photo. What we need to do is to reduce the text size. Re-open the same Settings window again, but this time
stay with the Text tab and set the Font Scaling to a much smaller value - say 100%. Click OK. The pedigree again changes, and this time we are
getting the kind of thing we were after - smaller text that is displayed above the photo without clipping or overlapping:

In practice, achieving a 'photo pedigree' style with photos for all the ancestors is quite hard because the ancestor cells at different generation
numbers vary greatly in shape: the deeper ancestors tend to have wide cells that are not at all deep, whereas the parents have cells that are deeper
than wide. The best approach is to always ensure that the photos you use have the same aspect ratio, then carefully customize the pedigree layout
to work reasonably well with a photo of that shape at each generation.
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Saving
'Saving' can mean several different things with PedPro - saving the pedigree data file, saving data as you work, exporting pedigrees as PDF/Image
files, or saving your data in a different format (exporting).

Saving The Pedigree Data File
In normal usage, you don't have to do anything to save the pedigree data file other than to close PedPro when you're done and confirm that you want
to save the changes when prompted. The first time you do this after creating a new data file, PedPro will ask you for a filename to save as. You
should save the file in the normal folder on your computer you use for your other data, such as documents.
Just as it is important to backup your other documents, it is essential that you backup your pedigree data file(s) from time to time: if you lose
a pedigree data file you will lose ALL the information you have ever entered into it.
You can also save the currently open data file under a new name - use File|Save As.

Saving Data as You Work
The way PedPro works is that when it opens a pedigree data file, it reads the entire file into memory and works with the in memory copy. Changes
you make whilst using the program - such as adding/editing records - are made to the in-memory copy. Then when you close the program, you are
asked if you want to save the changes. Assuming you confirm this, the data file is rewritten and the program closes. But if you choose not to save
the changes - e.g. as you might do if you realize you made a lot of changes in error - then your (previously) saved file is left as is. If the program is
terminated without saving the file, changes you have made since opening the file are lost.
If you want to save your data file without closing the program, you can do this by choosing File|Save. PedPro will remain open but all changes you
have entered prior to that point will be saved to the computer's file system.

Exporting Pedigrees and Other Forms as PDF/Image Files
Instead of printing a pedigree (or other form) to a physical device you can export it as a PDF or image file. For further information see Printing Exporting As PDF/Image Files.

Exporting Data
This is where you save your pedigree data in a different format, such as XML or text (CSV) - usually in preparation for importing your data into some
other software. It can also be used to export the data as HTML or PDF in the style of a tabular report. For further information see Exporting.
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Importing
When you create a new pedigree data file, you can either create it as an empty file, or you can start it off with pedigree data imported from another
file. PedPro can import pedigree data from Breeders Assistant and Pedigree Assistant, as well as Text (CSV) files.

Chapter Contents
1. From Text/CSV Files
2. From Breeders Assistant
3. From Pedigree Assistant
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Importing - From Text/CSV Files
PedPro supports import from text/CSV files. This lets you load data created by other applications and spreadsheets.
Choose File|Import Text/CSV Data, then select your import file. The file needs to be a text/CSV file - the kind of file that you might export from a
spreadsheet - but which can also be produced by many database and pedigree programs. You are then taken through a series of windows that let
you set options to control the way PedPro processes the import file. Note that in many cases there will be few if any of these settings that you
need to change, because PedPro inspects the data file and chooses sensible defaults for the file format and its contents.

Character Encoding
The Character Encoding window selects the character set encoding and line ending format. If the options presented here don't mean anything to
you, don't worry because in practice you are very unlikely to need to change these settings. If in doubt simply click Next to proceed.
The character set defines how the bytes in the file are encoded, such as UTF or ISO-8859-1. The line ending format says whether input lines are
terminated by carriage return, line feed, or both.

Column Formatting
The Column Formatting window controls the way that the columns are formatted in the file. This is where you choose whether the file is comma or
TAB separated, whether there is a header line, and whether column values are quoted. Again, it is unlikely you will need to change anything here.
Typically you just need to click Next to proceed.

Column Data
The Column Data window is where you define the meaning of each import column - i.e. where the name, sex, sire etc. are to be found in the input
data. It is likelier that you will need to alter the settings here than in the previous windows.
However, in many cases again PedPro is still able to deduce the correct meaning of columns in your data file. Before it displays the Column Data
window, PedPro inspects the first few lines of the input file and makes a reasonable 'guess' as to which columns contain the main pedigree data name/id, sire, dam, sex and date of birth.
To make changes, click the Customize checkbox. It can help at this stage to make the window wider and deeper.
For each input column, the rows shown are as follows:

Row

Meaning

Field

The meaning of the data in this column.

Type

The type of the data, such as Text, Integer, Date, etc. For some fields, e.g. date of birth, the type is implicit and you cannot change it.

Label

The label that is to be used for the field once the data has been imported into PedPro. This is only meaningful for fields that will become
user defined fields in your data file. For columns that map to inbuilt fields (like, sex or name), the label is not set here but can be set
separately. For further information see Customization.

Input
This will be shown in blue and shows the text from any header line that was found in the input data file. This is displayed purely for your
Header convenience when checking that the Field and Type have been set correctly.
Input
Data

Up to 4 lines of data, again shown in blue, taken from the input data file, for reference.

You should review the Field, Type and Label settings for each input column to be sure they are correct for the particular input data. Ensure that the
date format and male/female sex values are consistent for the input data file, then click Finish to proceed with the import.

Import Fields
The full list of fields is given below.

NOTE: Several of these fields are related to each other and need to be consistent within the input file in order to successfully import data. These
are the Name and ID fields.
Each input record (i.e., each animal) must have an ID field, a Sire ID field and a Dam ID field. These are used by PedPro to construct the ancestral
linkages - i.e. they are how it works out which parents any given animal is descended from. The ID fields can be numeric or text. Numeric IDs are
generally record numbers/keys as generated by whatever software created the import file.
Optionally, the import data may also contain a Name field. If present, this is used for each animal's name. If not present, the name is set to the ID.
If you are importing data that contains just the name of each animal, its sire and dam, without any kind of record number/key, you should import
these columns as the Animal ID, Sire ID and Dam ID (and not as 'Name' fields). The names will be then set automatically from the ID's.
Obviously the Sire/Dam ID/Name fields need to contain consistent data so that PedPro can work out the ancestral links correctly. In particular, if
you don't have a separate Name field (i.e. the ID's serve as the names), then make sure that titles are presented consistently. I.e. if your data has
animal titles embedded within the names in the ID column then they must also appear in the Sire ID/Dam ID columns. E.g. if your data contains an
animal with 'Ch. Fred' in the ID column, then for another animal's record to reference it as its sire, its sire ID column must be given as 'Ch. Fred'
and not 'Fred'. In general it is always better to have titles stored in a separate Title column where possible. This also has the benefit that PedPro
will automatically highlight titled animals in the pedigree, typically in red.

Meaning Notes
Animal ID A unique number or key for this animal. Mandatory if the Name is not given, otherwise optional.
Sire ID

Sire key/number. If present, the Animal ID field must also be included.

Dam ID

Dam key/number. If present, the Animal ID field must also be included.
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Name

Animal name.

Sex

Gender. The allowed values for male/female are given in boxes beneath the import definition table.

Date of
Birth

The date format is set using a dropdown menu beneath the import definition table.

Date of
Death

Using same date format as for date of birth.

Sire
Name

Name of the sire. If present, the Animal Name field must also be included.

Dam
Name

Name of the dam. If present, the Animal Name field must also be included.

User
Field

A user defined column. These are for any other columns present in your data file for which PedPro does not have an inbuilt field.
PedPro has a limit of 200 user definable fields in a data file.

Title

The animal's title. If you have control over the creation of the import data file it is much better to have the title given in a separate
column to the name. This allows it to be transferred to the dedicated title field, which in turn allows for titled animals to be
automatically highlighted in pedigrees (usually, in red).

Suffix

Suffix that is appended to the animal name when displayed in pedigrees.

Ignore

A column to be completely ignored in the input file.

Data Types
The full list of data types is as follows:

Type

Description

Text

Simple text column.

Date

Date value.

Integer

An integer value (i.e. no decimal point).

Number

A number that may include a decimal point.

Example Input Data Files
Here are some examples of different data formats, all of which are acceptable. For ease of display the examples shown here use comma separated
text (CSV) but you could just as easily use TAB separated or any other separator character.

Example: Very simple structure with a column for the gender and columns for the name, sire name and dam name.
SEX,NAME,SIRE,DAM
M,Comet,Favorite,Young Phoenix
M,Favorite,Bolingbroke,Phoenix
M,Bolingbroke,Foljambe,Young Strawberry
M,Foljambe,R. Barkers Bull,Haughton
F,Young Strawberry,Dalton Duke,Favorite cow
F,Phoenix,Foljambe,Favorite cow
F,Favorite cow,Alcocks Bull,
F,Young Phoenix,Favorite,Phoenix

Example 2: In this case the animal is given by both a name and an id number, and the sire/dam linkage is through the id number.
name,s_id,d_id,id
Arripay Blue Surprise,2,29,1,
Arripay Breaks Everything,26,22,2,
Arripay Brown Beauty,19,5,3,
Arripay Brown Boy,,,4,
Arripay Candy Girl,,,5,
Arripay Champagne Charlie,16,22,6,
Arripay Chocaholic,6,29,7,
Arripay Choccy Chips,,,8,
Arripay Dark Crystal,12,17,9,
Arripay Dark Magician,4,25,10,
...

Example 3: Similar to the above but this time with a column for date of birth.
ID,Sex,DOB,Sire,Dam
Abbots Wisdom,M,30/03/1930,Diver Of Woolley,Sewardstone Tess
Abbotsford Rosa of Tasvane,F,30/04/1986,Tasvane Taraius,Rachenco Sunshine
Alexander of Elsiville,M,15/05/1944,Torrdale Tinker,Zena Of Elsiville
Alexia of Tillwood Rachenco,F,30/04/1973,Spartan of Rachenco,Wayfarer of Tillwood
Alresford Advertiser,M,15/04/1951,Alexander of Elsiville,Alresford Mall
...
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Importing - From Breeders Assistant
PedPro supports import of pedigree data from Breeders Assistant.
Please note that PedPro is not intended to be a drop-in replacement to Pedigree Assistant. Some data is not transferred. Please refer to the
'Limitations' section at the end of this page for further details.

How To Import
1. Open PedPro.
2. Choose File|Import From Breeders Assistant, then select your old pedigree data file. If you are unsure what your old data file is called or
where to find it, refer to the next section for some hints on how to find it.
3. Once you have selected your input file, PedPro will inspect the file and its contents. If your source data file is large, this may take up to a
minute or so. Please be patient!
4. PedPro will then display a window in which you can select the fields you want to import from your old BA data file. It is important at this stage to
check carefully that the correct fields are selected. PedPro will automatically select any fields in which data has been found in your old file so
you may find you don't need to make any changes here. It will also correctly import any of the 'user defined' fields from BA including their field
names.
5. Click OK. The file will be imported. If your source data file is large, this may take up to a minute or so. Please be patient!
6. Your data is displayed in PedPro.
7. Use File|Save As to save the data as a PedPro data file.
8. This last step is optional but recommended: select File|Settings and then adjust (i) the User Fields and (ii) the Details Window Layout tabs.
This lets you control the names of the fields, their layout within the Record Details window and the order in which fields appear in pedigrees.
For further information see Customization.

How To Find Your Old Breeders Assistant Data File
This advice is intended to help you locate your pedigree data as stored by Breeders Assistant.
In normal use Breeders Assistant stores all your pedigrees in a single data file. Generally you would only have multiple data files if you have multiple
breeds or some other reason to keep records for one group of animals separate to another.
The filename and folder where this data file is stored will have been chosen by you when you first used BA. If you still have access to the installed BA
software you can find the filename and location by opening the program and selecting 'Database Properties' from the Database menu. This displays
information about the open data file, including the full filename. This is the file you need to import into PedPro.
Failing that, you can search the computer where you had BA installed. The filename extension you need to search for depends on which version of
BA you had - please refer to the table below. One way you can search for the file is with Windows Explorer: click the Windows 'Start' button, select
All Programs, then Accessories, choose Windows Explorer, then use the search box to search your whole computer for files matching the search
pattern below.

Product

Search For

Breeders Assistant for Cats

*.cdb

Breeders Assistant for Dogs

*.ddb

Breeders Assistant for Birds

*.bdb

Breeders Assistant (Generic)

*.adf

Breeders Assistant for Cavies

*.vdb

Breeders Assistant for Horses

*.hdb

Breeders Assistant for Rabbits

*.rdb

Breeders Assistant for Rats

*.rdf

Limitations
When you are importing data from Breeders Assistant please note that it does not transfer all your data. That is because Breeders Assistant has a
number of features that are not present in PedPro. It does, however, transfer virtually all the data you are are most likely to have used in your
pedigrees.
The following data from Breeders Assistant will not be transferred: contact records (apart from names of breeders/owners), show records, mating
records, trial mating records, accounts, appointments, vet records and vaccination records.
Within the animal records, the following rarely used fields will not be transferred: blood type, additional title highlight style, breed genotype, coat color
genotype, coat pattern genotype, disease genotype, eye color genotype, gestation period, 'missing' ancestor name, title highlight style, vaccination
summary, additional photos (2-4; the main photo filename is transferred), the 'is non-standard breed' flag, the 'ears cropped' flag & date, inbreeding
lock, inclusion in registration documents flag, the 'sex proven' flag, the 'tail docked' flag & date, and the mate name (BA/Birds only).
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Importing - From Pedigree Assistant
PedPro supports import of pedigree data from Pedigree Assistant.
Please note that PedPro is not intended to be a drop-in replacement to Pedigree Assistant. Some data is not transferred. Please refer to the
'Limitations' section at the end of this page for further details.

How To Import
1. Choose File|Import From Pedigree Assistant, then select your old pedigree data file. If you are unsure what your old data file is called or
where to find it, refer to the next section for some hints on how to find it.
2. Once you have selected your input file, PedPro will inspect the file and its contents. If your source data file is large, this may take up to a
minute or so. Please be patient!
3. PedPro will then display a window in which you can select the fields you want to import from your old PA data file. It is important at this stage to
check carefully that the correct fields are selected. PedPro will automatically select any fields in which data has been found in your old file so
you may find you don't need to make any changes here. It will also correctly import any of the 'user defined' fields from PA including their field
names.
4. Click OK. The file will be imported. If your source data file is large, this may take up to a minute or so. Please be patient!
5. Your data is displayed in PedPro.
6. Use File|Save As to save the data as a PedPro data file.
7. This last step is optional but recommended: select File|Settings and then adjust (i) the User Fields and (ii) the Details Window Layout tabs.
This lets you control the names of the fields, their layout within the Record Details window and the order in which fields appear in pedigrees.
For further information see Customization.

How To Find Your Old Pedigree Assistant Data File
This advice is intended to help you locate your pedigree data as stored by Pedigree Assistant.
In normal use Pedigree Assistant stores all your pedigrees in a single data file. Generally you would only have multiple data files if you have multiple
breeds or some other reason to keep records for one group of animals separate to another.
The filename and folder where this data file is stored will have been chosen by you when you first used PA. If you still have access to the installed PA
software you can find the filename and location by opening the program and selecting 'Database Properties' from the Database menu. This displays
information about the open data file, including the full filename. This is the file you need to import into PedPro.
Failing that, you can search the computer where you had PA installed. The filename extension you need to search for depends on which version of
PA you had - please refer to the table below. One way you can search for the file is with Windows Explorer: click the Windows 'Start' button, select
All Programs, then Accessories, choose Windows Explorer, then use the search box to search your whole computer for files matching the search
pattern below.

Product

Search For

Pedigree Assistant for Cats

*.cpd

Pedigree Assistant for Dogs

*.dpd

Pedigree Assistant (Generic)

*.gpd

Limitations
When importing from Pedigree Assistant the transfer includes all the data from your pedigrees but not the contact records (except for the names of
breeder/owner, which are transferred).
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Exporting
PedPro includes the means to export your pedigree data for transfer to other programs or for display as a table.

Text/CSV
Use this feature to transfer data from PedPro into other programs such as other pedigree programs. Whilst this can also be used for transfer to
spreadsheets you may find you can get better results with an XML export - see below.
Choose File|Export Data, then specify the output file to be created. Note this file will be overwritten if it already exists. Select the output file format which should be either a 'Text file' (*.txt) for a TAB separated file, or a 'CSV file' (*.csv) for a comma-separated file.
Next, the Export Text/CSV window is displayed. This lets you control the format of the export file, such as the character set and line ending style.
Note that in most cases you do not need to change anything here as the defaults are usually suitable - in which case just click Next to
proceed.
Finally, the Columns window appears. Here you can choose the fields from your data file that you want to be included in the export. Select whichever
fields you need, then click Finish.

Other Formats - XML, ODF, HTML and PDF
The export facility also supports other export formats.
To export in any of these formats, proceed initially as for text/CSV export - i.e. choose File|Export Data - but then select the required alternative
output file format.

Format Use
XML

Useful for transferring the data to a spreadsheet. Preferable to Text/CSV in this situation because the XML format also preserves data
type information, usually resulting in a better import into the spreadsheet.

HTML

An HTML file with a single table for all the data.

PDF

A Portable Document Format file.

ODF

Open Document Format. Use this when transferring the data to a word processor.
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Themes
PedPro groups most of the appearance information for all forms - fonts, borders, photo positioning etc. - together and this is referred to as a 'theme'.
There is always a current theme in force, and the name of this theme is shown in the Theme dropdown menu in the right panel. Initially, there is just
one theme, called 'Default'. You can create additional themes as you need, and then switch between them quickly by selecting from the dropdown.
Whenever you change the appearance of any part of the displayed form it is saved in the current theme.
Note that the theme does not extend to the presence, or absence of, the various boxes of a form. E.g. whether, or not, a pedigree includes a Logo
box or a Signature area, is not considered part of the theme. But, a theme does include all the details of the appearance of each those elements,
when they are visible.

Example: The default theme uses solid black lines for all box borders (for boxes that have them, that is), and all text in black. You might choose to
create a new theme that changes those colors to dark blue. To achieve this all you have to do is:
- select New Theme from the Theme dropdown menu
- give it a name. e.g. 'Dark Blue'
- right-click over the displayed form and select Form Defaults
- change the border color and fill color to dark blue, then click OK
From this point on, you can switch between the color schemes by just changing the selected theme.
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Inbreeding
PedPro can automatically compute and display the inbreeding coefficient.
To include the inbreeding coefficient in a form such as a pedigree: choose File|Settings, then click onto the System Fields tab, then double-click
the Inbreeding entry in the system field list. The Edit Field window opens, and amongst other things this lets you choose the situations in which
PedPro is to normally display the inbreeding coefficient. Within the Default Field Usage section ensure the option for the Pedigree Title is checked.
Click OK.
To control the number of generations of ancestors used in the calculation, and the precision with which it is reported, select Preferences from the
File menu.
For further information see Customization - Data Fields.
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Ancestor Highlighting
PedPro can automatically highlight the repeat and common ancestors in a pedigree or trial
mating.
To do this, click in the Ancestor Highlight selector in the right side panel, and select
either Highlight Repeat Ancestors or Highlight Common Ancestors.
A 'repeat' ancestor is one that appears at least twice within the displayed ancestors,
irrespective of whether or not it appears within the sire's or dam's sides of the pedigree.
A 'common' ancestor is one that appears at least once on both sides of the pedigree i.e. in
both maternal and paternal branches. Such ancestors are the source of inbreeding. A
'common' ancestor is always a 'repeat' ancestor, but not vice versa.

NOTE: The number of generations of ancestors that are used when computing inbreeding
is usually larger than the number that can be displayed within the pedigree. E.g. you might
Pedigree - Showing Highlighted Ancestors
have 5 generations shown in the pedigree, but use 16 when computing the inbreeding
coefficient. Because of this, it is possible to have no visible common ancestors in the
pedigree, yet have an inbreeding coefficient greater than zero. This happens when the nearest common ancestors lie beyond the displayed
ancestors. To adjust the inbreeding calculation, including the number of ancestor generations used, select Preferences from the File menu.
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Customization
PedPro provides extensive configuration/customization options. These can be accessed using buttons and settings in the right side panel and with
the Preferences and File Settings windows. You can also access many customization options though context popup menus - right-click over any
part of the displayed form then select one of the 'Settings' options.
The Preferences window is accessed through the File menu. It is used for settings that are independent of any particular data file.
The File Settings window is accessed through the File menu and is used for all settings that can alter the current data file in some way - such as
user defined data fields.

Chapter Contents
1.
2.
3.
4.
5.

Quick Reference
Data Fields
Record Details window
Select Record window
Name Format
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Customization - Quick Reference
The following table lists all available customization options and how to access them.

Category

See

Date Format

Select Preferences from the File menu, then click on the System tab. Note that the date format used when
importing CSV data is set as part of the import text/CSV options.

Base Font

First ensure the Design Mode option (in the right side panel) is turned on. Then adjust the base font style &
size.

Title Highlighting

Select File|Settings, then click on the General tab.

Data Fields

Select File|Settings, then use the User Fields & System Fields tabs.

Record Details window

Select File|Settings, then use the Details Window Layout tab.

Select Record window

Select File|Settings, then use the Select Window Layout tab.

Include Inbreeding
CoefficientIn the Pedigree

See Inbreeding.

Inbreeding Depth & Precision

Select Preferences from the File menu, then click on the Inbreeding tab.

Terminology

PedPro uses a number of terms (words) that can appear indirectly in forms e.g. as labels for data fields, etc.
These are words such as 'Sex', 'Male', etc.
To customize these terms select Preferences from the File menu, then click on the Terminology tab. A
number of preset choices are available for English-speaking breeders of cats, dogs, etc. Alternatively, select
Custom from the dropdown menu then can change each term individually.

NOTE: Other terms, such as 'Pedigree', are directly built into the forms. To change these you should alter the
form settings: right-click over the element (box) you want to change, then select the appropriate 'Settings'
window from the popup menu.

Box Sizes

First ensure the Design Mode option (in the right side panel) is turned on. Then drag the dividers that
separate the form boxes to resize as needed.
For further information see Form Design.

Print Margins

In the main window, click the margins icon (

) which is in the side panel to the right of the displayed form.

For further information see Printing - Margins.

Paper Orientation

To switch between Portrait and Landscape layout click the landscape (
amongst the buttons in the side panel to the right of the form).

) and portrait (

) icons (these are

Background Photo (Watermark
Image)

Right-click over the pedigree, select Background Settings, then click Add Photo.

Select Data Fields

E.g. to choose the data fields that are to be included in any given part of a pedigree. Select File|Settings,
then edit fields in the User Fields & System Fields tabs to change their usage.

For further information see Form Design - Background Photos.

For further information see Customization - Data Fields.

Borders Text Color Text Sizes To access many design options, right-click over the form, then select from the 'Settings' options on the popup
Background (Fill) Color & Many menu. See Form Design - Structure and Form Design - Box Settings.
Other Layout Options
Field Ordering in Forms

Select File|Settings, then use the Form Field Order tab.

35

Customization - Data Fields
For each animal PedPro stores a variety of information such as sex, name and so on. These are called 'data fields'.
Several data fields are built in - e.g. date of birth. These are known as 'system fields'. They are listed below.
You can extend the standard list of fields by adding your own. Such fields are called 'user defined fields' or simply 'user fields'. PedPro has a limit of
200 user fields.
When you create a new data file, PedPro lets you choose from a selection of commonly used fields to add to the file - such as registration number,
breeder name and so on.
Data fields can be customized in a number of ways:
Add, delete and edit the user defined fields: choose File|Settings, then select the User Fields tab.
Change the way in which the Name field is displayed - See Customization - Name Format.
Change the labels used by system fields (by adjusting the terminology settings - select Preferences from the File menu, then click on the
Terminology tab).
Change the field usage - i.e. control where they appear in forms: choose File|Settings, then edit the individual fields on the User Fields &
System Fields tabs.
Change the order in which fields are listed in forms: choose File|Settings, select the Form Field Order tab, then adjust the ordering as
required.
Customize the layout of the Record Details window - you can control the size and positioning of the fields within the window and organize them
into different tabs. See Customization - Record Details window.
Customize the Select Record window by choosing the fields you would like to see displayed in its 'Key Fields' panel. See Customization Select Record window.

System Fields
The following table lists all the fixed fields that are built in to PedPro and which are always available.
To control the names used by these fields select Preferences from the File menu, then click on the Terminology tab.

Field

Purpose

Date of
Birth

Self explanatory.

Date of
Death

Self explanatory.

Sex

The animal's gender.

Sire and
Dam

Name of the sire and the dam.

Suffix

The name suffix. There is an option to have this automatically appended to the animal's name when it appears in a form. See
Customization - Name Format.

Title

The animal's title. This is prepended to the animal's name when it appears in a form, and its presence determines whether the
name is displayed with title highlighting applied. See Customization - Name Format.

Inbreeding The inbreeding coefficient. Computed as needed (i.e., it is not stored in your data file). See Inbreeding.
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Customization - Record Details window
The Record Details window is used whenever you add a new animal or edit the details of an existing animal in your data file.
The layout of this window is highly configurable - you can control the data fields that are present, their size and appearance, and organize them into
different tabs.
There are 2 stages to customizing this window. First, you need to set up all the fields you want to use - add new fields and customize the existing
fields e.g. by changing their labels and their size. Next, you should organize the fields by setting up their ordering within the Record Details window,
and assign them to different tabs and columns.

NOTE: The Record Details window is resizable - if you resize the window in the usual way (drag the bottom-right corner) then PedPro will remember
the size and use it from that point on.

Adding and Customizing Fields
All these customizations are made using the File Settings window (choose File|Settings).
To add a new field select the User Fields tab, then click the Add button.
Or, to adjust an existing field, find the field you want to change (on either the User Fields or System Fields tabs), select it in the list and either
double-click it or click the Edit button.
To permanently remove a user field, find it on the User Fields tab and click the Delete button. WARNING! Deleting an existing field will discard

ALL data for that field within the pedigree data file that is currently open.
The following table summarises the different properties you can control for each field.

Property

Description

Field Name

The field name or label as it will appear both within the Record Details window and in forms.
For user fields you can set the name to whatever you like.
With system fields the name is not directly editable. System field names are derived from the current terminology
settings. To alter those, use the Terminology tab of the Preferences window.

Required

You can choose whether to mark a field as being required or not. A required field is one where you are forced to enter
data when adding or editing a record. Once a field has been marked as required, whenever you add or edit a record you
will have to enter data in that field in order to save the record.
This condition will not be forced on any existing records that were present at the time you mark a field as being required i.e. existing record fields that do not contain data for a field subsequently marked as required will continue to be empty
until you next edit the record.

Show as a 'Key
Field' within the
Select Record
window

It is generally useful to have the more important fields listed in the Select Record window - such as sex, date of birth
and so on. This is the window that is used whenever PedPro needs you to select a record e.g. when choosing a sire
within a pedigree.

Data Type

This is the type of field - text, date, etc. Note that the data type is fixed for system fields and cannot be changed.

This checkbox lets you choose which fields will be shown as 'Key Fields'.

Please refer to the next section below for information about the different data types supported.

Default Field Usage

This lets you select which parts of the forms the field is to appear in, by default.
E.g. you may want to have some fields appear in the pedigree title, but not necessarily within the ancestors table.

Display Settings

These control aspects of the how the field value is displayed within a a form.
The available options depend on the field data type.

Edit Settings

These settings control how the field value is displayed and manipulated within the Record Details window.
The available options depend on the field data type.

Field Data Types
The following field types are provided:

Data Type

Description

Text

Single line text fields.
Probably the most important field type, this is where the data is one line of text at most.

Editing Settings: Choose the minimum width of the text box, and whether a dropdown list of previously entered values is to be
maintained. The latter is useful for any field where you want consistency across records or you want to save time by being able to
select from known values. E.g. for a breed or color field. Dropdown lists can be private to a single field, or the same list can be
shared over multiple fields. E.g. if you have an eye color field you would probably have no need to have its dropdown list visible to
other fields. But if you have breeder and owner fields you might find it useful to use a shared dropdown list of names of previously
entered people. You can also specify the default field value.

Display Settings: You can choose whether a field is to use word wrap or not. A word wrapped field will automatically be broken
into multiple lines if there is insufficient space on the form. You can also setup a case conversion setting to force a field to be
displayed in forms in UPPER CASE or Sentence Case irrespective of how you have entered the data.
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Multiline
Text

A text field that can span multiline lines.

Editing Settings: You can set the width (no. characters) and height (no. of lines) for the data entry box, and the default text for new
records.

Display Settings: As for single line text fields.
Choice

A selection of one of a predefined set of text values.

Editing Settings: Specify the list of possible values, and whether the value is chosen using a dropdown list or a series of radio
buttons.

Display Settings: None.
Integer

A whole number (i.e. no decimal part).

Editing Settings: You can specify a minimum and maximum value, and whether the data is entered using a plain box or a 'spin
box'.

Display Settings: You can choose a suffix which will be output after the value. E.g. if you had a field for, say, the number of
Champion Certificates awarded, you might set a suffix of 'Ccs'.

Date

A value that is a calendar date.

Editing Settings: You can set a default date to be used for new records.
Display Settings: None. However you can set the output format for all dates separately. See Customization - Quick Reference.
Percentage A percentage value from 0% to 100%.
Editing Settings: You can specify a minimum and maximum value, and whether the data is entered using a plain box or a 'spin
box'.

Display Settings: Choose the number of decimal places (precision) to be output.
Number

A number that may have a decimal part.

Editing Settings: You can specify a minimum and maximum value, and whether the data is entered using a plain box or a 'spin
box'.

Display Settings: You can choose a suffix which will be output after the value. E.g. if you had a field for, say, weight, you might set
a suffix of 'Kg'.

Boolean

Boolean (logical) value - true or false.

Editing Settings: You can specify the default field value (true/false) and whether to use a checkbox or radio buttons to set the
value.

Display Settings: Specify the text to be output for true and false values.

Ordering Fields and Setting Up Tabs and Columns
Once you have set up all the fields you want to use, the next step is to control their placement within the Record Details window. You do this from the
Details Window Layout tab of the File Settings window.
On this tab you will see a list of all the fields (both user and system) excepting for the name, sex and photo (the positioning of these fields is not
configurable).
All the fields listed will be added to the Record Details window in the order given.
By default, PedPro will try to arrange the fields automatically. This does a reasonable job but you may well prefer to manually set your own
placement. To change that order, first uncheck the Determine layout automatically box and then:
Move fields up or down the list. To move a field, select it then use the Up or Up button.
Force a field to start a new column in the Record Details window - check the New Column checkbox.
Force a field to start a new dialog tab in the Record Details window - just enter the tab label in the New tab box.
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Customization - Select Record window
The Select Record window is used whenever you want to choose an animal record from a list, e.g. when choosing the sire in a pedigree. This
window has a 'Key Fields' panel which is used to show the more important fields for the currently selected animal in that window. You can control
which fields are included in that 'Key Fields' panel and their order.

NOTE: The Select Record window is resizable - if you resize the window in the usual way (drag the bottom-right corner) then PedPro will remember
the size and use it from that point on.
To have a field appear in the 'Key Fields' panel what you need to do is first locate the field on either the User Fields or System Fields tab of the File
Settings window (choose File|Settings). Next, edit the field's details by selecting it and clicking the Edit button. Then in the Edit Field window,
check the Show as a 'Key Field' within the Select Record window option.
Once you have selected the fields you want to include in the 'Key Fields' panel, you can optionally adjust their order of display. You do this from the
Select Window Layout tab of the File Settings window.
On this tab you will see a list containing most of the fields (both user and system).
All the fields listed will be shown in the 'Key Fields' panel in the order given.
By default, PedPro will try to arrange the fields automatically. This does a reasonable job but you may well prefer to manually set your own
placement. To change that order, first uncheck the Determine layout automatically box and then:
Move fields up or down the list. To move a field, select it then use the Up or Up button.
Force a field to start a new column, check the New Column checkbox.
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Customization - Name Format
PedPro has options to adjust the formatting of animal names in forms.
To set these options, choose File|Settings, then select the General tab.

Title Highlighting - this controls how an animal's name is emphasized when it has a title. It is commonplace in pedigrees for the name of titled
animals such as Champions to be given in red, bold or some other form of emphasis.
Include suffix in names - whether or not the Suffix field (a system field) is to be appended to animal names when displayed in forms.
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FAQs
Listed here is a selection of some of the more commonly asked questions about PedPro.
Additional questions and answers can be found on our web site.
Q: Where do I change the date format?
A: Select Preferences from the File menu, then click on the System tab.
Note that the date format used when importing CSV data is set as part of the import options.
See Importing.
Q: How do I add/delete data fields?
A: Select File|Settings, then click on the User Fields tab. Here you can add/remove/rename the available fields.
See Customization - Data Fields.
Q: How do I change the order of data fields e.g. in the pedigree title?
A: Select File|Settings, then click on the Form Field Order tab. Move the fields up and down the list.
See Customization - Data Fields.
Q: How do I choose which fields are included in the pedigree?
A: Select File|Settings, then adjust the 'Default Field Usage' for the fields in the User Fields and System Fields tabs.
See Customization - Data Fields.
Q: How do I set up a background image (watermark)?
A: All you need do is right-click over the form, select Background Settings, then click Add Photo.
See Form Design - Background Photos.
Q: How do I get Champions etc. to be highlighted in the pedigree e.g. in red?
A: Make sure that you enter the title part of the name into the separate Title box in the Animal Details window; don't include it as part of the name.
This way PedPro will know to use title highlighting when displaying the name e.g. in a pedigree.
To change the way names are highlighted - e.g. to have them in bold rather than red - select File|Settings, then select a different Title
Highlighting option.
See Customization - Name Format.
Q: How do I customize PedPro?
A: Customizations that are not specific to the current pedigree data file - display preferences etc. - are controlled using the Preferences window select Preferences from the File menu.
Customization specific to the pedigree data - such as the user defined fields - are controlled using the File Settings window - select
File|Settings.
See Customization.
Q: How do I uninstall PedPro?
A: Windows: Open Control Panel and select 'Uninstall a Program' or 'Add/Remove Software'.
Mac: Just drag PedPro to the trash can.
Q: What extra do I get with the full (paid) version?
A:
It is not limited to 30 days use
It works with data files of up to 1,000,000 records whereas the free trial is limited to 50
Export and print facilities are enabled
Printed forms do not include a 'trial version' message
Access to support and updates
Q: How do I place an order?
A: See our web site.
Q: My question isn't answered here, where else can I look?
A: Please see the Frequently Asked Questions page on our web site, which we update regularly. This addresses many additional topics and
questions to those listed here.
Q: My question isn't answered in the FAQs, neither here nor on the PedPro web site. How can I contact product support?
A: Please see Product Support on our web site.
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Product Support
To contact customer service please see the Product Support page on our web site.
Before contacting customer service, be sure to check the FAQ on our web site first. This covers many commonly asked questions, and may well
address the problem or query that you have.
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Release Notes
System Requirements
PedPro requires Windows 10, Windows 8, Windows 7 or Windows Vista (either 32 or 64 bit).
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Revision History
RELEASE
VERSION DATE
3.1.01

14 May 2018

DETAILS
Added inconsistency checking facility (Record menu) to detect sex & DOB inconsistencies and self-parenting
errors within ancestors.
Added Copy/Save for the bottom messages area (on the View menu).
Now displays 'ERROR' for inbreeding coefficient when an ancestor circularity is detected.
Fixed a potential crash when an ancestor circularity is detected in some situations.
Other maintenance and fixes.

3.0.01

10 October
2016

Addition of multiline text fields.
Many fields in the System Fields and User Fields tabs of the File Settings now have additional options.
Means to customize the placement of fields within the Record Details window (order, columns, multiple tabs, label
above, radio enums).
Means to customize the select record window: choose which fields appear in the 'Key Fields' area, and their
ordering and multiple columns.
Can now import pedigree data directly from Breeders Assistant and Pedigree Assistant without needing to first
convert to text/CSV.
Record list(s) are now displayed down the left side.
Reorganized user interface, with buttons only above the displayed form and all other controls in a right side panel
which can now be hidden.
Addition of 'Details' boxes to pedigree and trial mating forms.
PedPro now supports up to 100 user defineable fields.

2.3.02

11 July 2014

Additional options in the Preferences|Terminology selector, and additional sample pedigrees.
User fields, and the DOB field, do not now default to being included in the ancestors of a pedigree on import.
Trial matings default to display inbreeding coefficient.

2.3.01

18 June 2014

Internal changes.

2.3.00

27 May 2014

Maintenance release.

2.2.03

April 2014

Bugfix, could cause crash after use of File Settings in certain circumstances.

2.2.02

March 2014

Initial public release.
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